# Table of Contents

Copyright and Trademarks ................................................................. 1  
General Overview .............................................................................. 2  
Equipment Diagrams........................................................................ 3  
Important Safety Information .............................................................. 4  
   Introduction ...................................................................................... 4  
   Electrical Safety ............................................................................ 4  
Description .......................................................................................... 5  
   Overview .......................................................................................... 5  
Installing ............................................................................................... 6  
   Installing the Equipment and Commissioning.................................. 6  
Operation .............................................................................................. 8  
   Operating the Equipment ................................................................. 8  
Equipment Specifications ................................................................. 9  
   Environmental Conditions .............................................................. 9  
Routine Maintenance .......................................................................... 10  
   Responsibility ................................................................................. 10  
   General ............................................................................................ 10  
Laboratory Teaching Exercises ......................................................... 11  
   Index to Exercises .......................................................................... 11  
   Nomenclature ................................................................................. 11  
Exercise A ........................................................................................... 13  
Operating the Optional Software (F1-301) ...................................... 17  
Contact Details for Further Information .......................................... 24
Disclaimer
This document and all the information contained within it is proprietary to Armfield Limited. This document must not be used for any purpose other than that for which it is supplied and its contents must not be reproduced, modified, adapted, published, translated or disclosed to any third party, in whole or in part, without the prior written permission of Armfield Limited.

Should you have any queries or comments, please contact the Armfield Customer Support helpdesk (Monday to Thursday: 0830 – 1730 and Friday: 0830 - 1300 UK time). Contact details are as follows:

<table>
<thead>
<tr>
<th>United Kingdom</th>
<th>International</th>
</tr>
</thead>
<tbody>
<tr>
<td>(0) 1425 478781 (calls charged at local rate)</td>
<td>+44 (0) 1425 478781 (international rates apply)</td>
</tr>
<tr>
<td>Email: <a href="mailto:support@armfield.co.uk">support@armfield.co.uk</a></td>
<td></td>
</tr>
<tr>
<td>Fax: +44 (0) 1425 470916</td>
<td></td>
</tr>
</tbody>
</table>

Copyright and Trademarks
Copyright © 2012 Armfield Limited. All rights reserved.

Any technical documentation made available by Armfield Limited is the copyright work of Armfield Limited and wholly owned by Armfield Limited.

Brands and product names mentioned in this manual may be trademarks or registered trademarks of their respective companies and are hereby acknowledged.
General Overview

Fluid mechanics has developed as an analytical discipline from the application of the classical laws of statics, dynamics and thermodynamics, to situations in which fluids can be treated as continuous media. The particular laws involved are those of the conservation of mass, energy and momentum and, in each application, these laws may be simplified in an attempt to describe quantitatively the behaviour of the fluid.

The hydraulics bench service module, F1-10, provides the necessary facilities to support a comprehensive range of hydraulic models each of which is designed to demonstrate a particular aspect of hydraulic theory.

The specific hydraulic model that we are concerned with for this experiment is the Flow Meter Test Rig, F1-21. This consists of a Venturi meter, a variable area meter and an orifice plate installed in a series configuration to allow for direct comparison. A full description of the apparatus is given later in these texts.
Equipment Diagrams

Figure 1: F1-21 Flow Meter Demonstration Apparatus
Important Safety Information

Introduction
Before proceeding to operate the equipment described in this text we wish to alert you to potential hazards so that they may be avoided.

Although designed for safe operation, any laboratory equipment may involve processes or procedures which are potentially hazardous. The major potential hazards associated with this particular equipment are listed below.

- Injury through misuse
- Injury from electric shock
- Damage to clothing
- Risk of infection due to lack of cleanliness

Accidents can be avoided provided that equipment is regularly maintained and staff and students are made aware of potential hazards list of general safety rules is included in the F1 Product Manual to assist staff and students in this regard. The list is not intended to be fully comprehensive but for guidance only.

Please refer to the notes in the F1 Product Manual regarding the Control of Substances Hazardous to Health Regulations.

Electrical Safety
The F1-10 Service Bench operates from a mains voltage electrical supply. The equipment is designed and manufactured in accordance with appropriate regulations relating to the use of electricity. Similarly, it is assumed that regulations applying to the operation of electrical equipment are observed by the end user.

However, to give increased operator protection, Armfield Ltd have incorporated a Residual Current Device (RCD, alternatively called an Earth Leakage Circuit Breaker or ELCB) as an integral part of the service bench. If through misuse or accident the equipment becomes electrically dangerous, an RCD will switch off the electrical supply and reduce the severity of any electric shock received by an operator to a level which, under normal circumstances, will not cause injury to that person.

Check that the RCD is operating correctly by pressing the TEST button. The circuit breaker MUST trip when the button is pressed. Failure to trip means that the operator is not protected and the equipment must be checked and repaired by a competent electrician before it is used.
Description
Where necessary, refer to the drawings in the Equipment Diagrams section.

Overview
The accessory is designed to be positioned on the side ledges of the channel in the top of the F1-10 Hydraulics Bench.

The Venturi flow meter, variable area flow meter and the orifice plate are installed in a series configuration to permit direct comparison of the same flow rate.

Flow through the test section is regulated using a flow control valve located downstream of the flow meters. This together with the control valve on the F1-10 Hydraulics Bench permits variation of the system static pressure.

Pressure tappings in the circuit are connected to an eight-bank manometer which incorporates an air valve in the top manifold with the facility to connect a hand operated air pump. This enables the water levels in the manometer bank to be adjusted up or down to a convenient level to suit the system static pressure. The pressure tappings connected to the manometers are arranged to show the differential pressures (the head losses) across each of the flow measuring devices together with the head at the throat of the Venturi and the head immediately downstream of the orifice plate that are used to calculate the flow rate of the water.
Installation

Installing the Equipment and Commissioning

The Flowmeter Demonstration apparatus is supplied ready for use and only requires connection to the F1-10 Hydraulics Bench as described below.

Carefully remove the components from the cardboard packaging. Retain the packaging for future use.

Locate the apparatus over the moulded channel in the top of the bench and ensure that the base plate is horizontal. Adjust the feet on the base plate if necessary.

Connect the flexible inlet tube at the bottom left hand end to the quick release fitting in the bed of the channel.

Place the free end of the flexible outlet tube in the volumetric tank of the bench.

Fully open the outlet flow control valve at the top left hand end of the apparatus.

Close flow control valve on the F1-10 Hydraulics Bench then start the service pump.

Gradually open the bench flow control valve and allow the pipework to fill with water until all air has been expelled from the pipework.

In order to bleed air from the pressure tapping points and the manometers close both the bench flow control valve and the outlet flow control valve and open the air bleed screw. Remove the cap from the adjacent air inlet/outlet connection. Connect a length of small bore tubing from the air valve to the volumetric tank. Now, open the bench flow control valve and allow flow through the manometers to purge all air from them; then, tighten the air bleed screw and partly open both the bench valve and the outlet flow control valve. Next, open the air bleed screw slightly to allow air to enter the top of the manometers, re-tighten the screw when the manometer levels reach mid height.

Gradually increase the volume flowrate until the variable area flowmeter indicates full scale (adjust the bench flow control valve and the outlet flow control valve in combination to maintain all of the readings within the range of the manometer). If the pattern is too low on the manometer open the bench flow control valve to increase the static pressure. If the pattern is too high open the outlet flow control valve on the apparatus to reduce the static pressure.

These levels can be adjusted further by using the air bleed screw and the hand pump supplied. The air bleed screw controls the air flow through the air valve, so when using the hand pump, the bleed screw must be open. To retain the hand pump pressure in the system, the screw must be closed after pumping.

If the levels in the manometer are too high then the hand pump can be used to pressurise the top manifold. All levels will decrease simultaneously but retain the appropriate differentials.

If the levels are too low then the hand pump should be disconnected and the air bleed screw opened briefly to reduce the pressure in the top manifold. Alternatively the outlet flow control valve can be closed to raise the static pressure in the system which will raise all levels simultaneously.
If the level in any manometer tube is allowed to drop too low then air will enter the bottom manifold. If the level in any manometer tube is too high then water will enter the top manifold and flow into adjacent tubes.

**Note:** If the static pressure in the system is excessive, e.g. with the bench flow control valve fully open and the outlet flow control valve almost closed, it will not be possible to use the hand pump to lower the levels in the manometer tubes. The valves should be adjusted to provide the required flowrate at a lower static pressure.

In operation the pressure drop across each flowmeter and the differential pressure created by the orifice plate and Venturi are compared with the volume flowrate which is measured using the volumetric measuring tank and a stopwatch (not supplied).

Close the bench flow control valve then switch off the service pump.

The F1-21 Flowmeter Demonstration apparatus is ready for use.
Operation
Where necessary, refer to the drawings in the Equipment Diagrams section.

Operating the Equipment
See Laboratory Teaching Exercises for details on operating the equipment.
Equipment Specifications

Environmental Conditions
This equipment has been designed for operation in the following environmental conditions. Operation outside of these conditions may result reduced performance, damage to the equipment or hazard to the operator.

a. Indoor use;
b. Altitude up to 2000m;
c. Temperature 5°C to 40°C;
d. Maximum relative humidity 80% for temperatures up to 31°C, decreasing linearly to 50% relative humidity at 40°C;
e. Mains supply voltage fluctuations up to ±10% of the nominal voltage;
f. Transient over-voltages typically present on the MAINS supply;
   Note: The normal level of transient over-voltages is impulse withstand (over-voltage) category II of IEC 60364-4-443;
g. Pollution degree 2.
   Normally only nonconductive pollution occurs.
   Temporary conductivity caused by condensation is to be expected.
   Typical of an office or laboratory environment.
Routine Maintenance

Responsibility
To preserve the life and efficient operation of the equipment it is important that the equipment is properly maintained. Regular maintenance of the equipment is the responsibility of the end user and must be performed by qualified personnel who understand the operation of the equipment.

General
Little maintenance is required but it is important to drain all water from the pipework when not in use.

Any manometer tube which does not fill with water or is slow to fill or empty indicates that the tapping in the pipework or the connection at the base of the manometer tube is blocked or partially blocked. Disconnect the flexible connecting tube between the pipe fitting and the manometer. Blowing through the tapping will usually dislodge any foreign body.

A few drops of wetting agent introduced into the manometer tubes will reduce the meniscus with the glass wall and improve measurement accuracy.
## Laboratory Teaching Exercises

### Index to Exercises

**Exercise A**

### Nomenclature

<table>
<thead>
<tr>
<th>Name</th>
<th>Unit</th>
<th>Symbol</th>
<th>Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Pipe Area</td>
<td>m²</td>
<td>$A_1$</td>
<td>$7.92 \times 10^{-4}$</td>
<td>Cross-sectional area of the test section. (Calculated from Diameter of 31.749 mm)</td>
</tr>
<tr>
<td>Orifice Area</td>
<td>m²</td>
<td>$A_2$</td>
<td>$3.14 \times 10^{-4}$</td>
<td>Cross-sectional area of the orifice in the orifice plate meter. (Calculated from Diameter of 20.0 mm)</td>
</tr>
<tr>
<td>Venturi Area</td>
<td>m²</td>
<td>$A_2$</td>
<td>$1.77 \times 10^{-4}$</td>
<td>Cross-sectional area at the throat of the Venturi meter. (Calculated from Diameter of 15.0 mm)</td>
</tr>
<tr>
<td>Volume Collected</td>
<td>m³</td>
<td>$V$</td>
<td>Measured</td>
<td>Taken from scale on hydraulics bench. The volume is measured in litres. Convert to cubic metres for the calculation (divide reading by 1000).</td>
</tr>
<tr>
<td>Time to Collect</td>
<td>s</td>
<td>$t$</td>
<td>Measured</td>
<td>Time taken to collect the known volume of water in the hydraulics bench.</td>
</tr>
<tr>
<td>Variable Area Meter Reading</td>
<td>l/min</td>
<td></td>
<td>Measured</td>
<td>Reading from variable area meter scale.</td>
</tr>
<tr>
<td>$h_x$</td>
<td>m</td>
<td></td>
<td>Measured</td>
<td>Measured value from the appropriate manometer. The value is measured in mm. Convert to metres for the calculation.</td>
</tr>
<tr>
<td>Timed Flow Rate</td>
<td>m³/s</td>
<td>$Q_t$</td>
<td>Calculated</td>
<td>$Q_t = \frac{V}{t} = \frac{\text{Volume Collected}}{\text{Time to Collect}}$</td>
</tr>
<tr>
<td>Variable Area Flow Rate</td>
<td>m³/s</td>
<td>$Q_a$</td>
<td>Calculated</td>
<td>Convert from instrument reading (divide by 60,000).</td>
</tr>
<tr>
<td>Orifice Plate Flow Rate</td>
<td>m³/s</td>
<td>$Q_o$</td>
<td>Calculated</td>
<td>$Q_o = \sqrt{\frac{C_d A_2}{1 - \left(\frac{A_2}{A_1}\right)^2}} \sqrt{\frac{2\Delta p}{\rho}}$</td>
</tr>
<tr>
<td>Armfield Instruction Manual</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Venturi Meter Flow Rate</th>
<th>$\text{m}^3/\text{s}$</th>
<th>$Q_t$</th>
<th>Calculated</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>$Q_{v} = \frac{C_d A_2}{\sqrt{1 - \left(\frac{A_2}{A_1}\right)^2}} \sqrt{\frac{2\Delta p}{\rho}}$</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variable Area % Flow Rate Error</th>
<th>%</th>
<th>Calculated</th>
<th>$(Q_a - Q_t/Q_t) \times 100$</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Orifice Plate % Flow Rate Error</th>
<th>%</th>
<th>Calculated</th>
<th>$(Q_o - Q_t/Q_t) \times 100$</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Venturi Meter % Flow Rate Error</th>
<th>%</th>
<th>Calculated</th>
<th>$(Q_v - Q_t/Q_t) \times 100$</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Variable Area Head Loss</th>
<th>mm</th>
<th>$H_a$</th>
<th>Calculated</th>
<th>$H_a = h_4 - h_5$</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Orifice Plate Head Loss</th>
<th>mm</th>
<th>$H_o$</th>
<th>Calculated</th>
<th>$H_o = h_6 - h_8$</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Venturi Head Loss</th>
<th>mm</th>
<th>$H_v$</th>
<th>Calculated</th>
<th>$H_v = h_1 - h_3$</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Timed Flow Rate Squared</th>
<th>$Q_c^2$</th>
<th>Calculated</th>
<th>Used to demonstrate the relationship between flow rate and losses</th>
</tr>
</thead>
</table>
Exercise A

Objective
To investigate the operation and characteristics of three different basic types of flowmeter, including accuracy and energy losses.

Method
By measurement of volume flow rates and associated pressure losses with three flowmeters connected in series and using timed volume collection to produce a reference measurement of flow rate.

Equipment
In order to complete the demonstration we need a number of pieces of equipment.
- The Hydraulics Bench which allows us to measure flow by timed volume collection.
- The F1-21 Flow Meter Apparatus
- A stopwatch to allow us to determine the flow rate of water.

Theory
Application of the Bernoulli equation yields the following result which applies for both the Venturi meter and the orifice plate.

Volume flow rate

\[
Q_v = \frac{C_d A_2}{\sqrt{1 - \left(\frac{A_2}{A_1}\right)^2}} \sqrt{\frac{2\Delta p}{\rho}}
\]

where

\[
\sqrt{\frac{2\Delta p}{\rho}} = \sqrt{2g\Delta h}
\]

and

\[
\Delta h \text{ is the head difference in m determined from the manometer readings for the appropriate meter, as given above}
\]

\[
g \text{ is the acceleration due to gravity, in m/s}^2
\]

\[
C_d \text{ is the discharge coefficient for the meter, as given below}
\]

\[
A_1 \text{ is the area of the test pipe upstream of the meter, in m}^2
\]

\[
A_2 \text{ is the throat area of the meter, in m}^2
\]
Use of a discharge coefficient, $C_d$, is necessary because of the simplifying assumptions made when applying the Bernoulli equations. Values of this coefficient are determined by experiment; the assumed values used in the software are:

For the Venturi meter: $C_d = 0.98$, $A_2 = 1.77 \times 10^{-4} \text{ m}^2$

For the Orifice plate: $C_d = 0.63$, $A_2 = 3.14 \times 10^{-4} \text{ m}^2$

Common pipework: $A_1 = 7.92 \times 10^{-4} \text{ m}^2$

The energy loss that occurs in a pipe fitting (so-called secondary loss) is commonly expressed in terms of a head loss ($h$, metres), and can be determined from the manometer readings. For this experiment, head losses will be compared against the square of the flow rate used.

**Equipment Set Up**

Place the flowmeter test rig on the bench and ensure that it is level (necessary for accurate readings from the manometers). Connect the inlet pipe to the bench supply and the outlet pipe into the volumetric tank, then secure the end of the pipe to prevent it moving about. Start the pump and open the bench valve and the test rig flow control valve, to flush the system.

In order to bleed air from the pressure tapping points and manometers, close both the bench and test rig valves, open the air bleed screw and remove the cap from the adjacent air valve. Connect a length of small bore tubing from the air valve to the volumetric tank. Next, open the bench valve and allow flow through the manometer tubes to purge them of air. Then tighten air bleed screw and partly open the test rig flow control valve and partly close the bench valve. Now open the air bleed screw slightly to allow air to be drawn into the top of the manometer tubes. Re-tighten the screw when the manometer levels reach a convenient height.

Check that all manometer levels are on scale at the maximum flow rate (full-scale reading on the variable area meter). These levels can be adjusted further by using the air bleed screw or the hand pump supplied.

**Results**

At a fixed flow rate, record all manometer heights and the variable area meter reading and carry out a timed volume collection using the volumetric tank. This is achieved by closing the ball valve and measuring (with a stopwatch) the time taken to accumulate a known volume of fluid in the tank, as measured from the sight-glass. You should collect fluid for at least one minute to minimise timing errors. Repeat this measurement twice to check for consistency and then average the readings.

Ensure that you understand the operating principle of each of the three flowmeters.
<table>
<thead>
<tr>
<th>Test No.</th>
<th>Critical Area (m²)</th>
<th>Penetration Area (m²)</th>
<th>Time to Collect (sec)</th>
<th>Volume Collected (m³)</th>
<th>Rate (mm/min)</th>
<th>(mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Conclusion
Comment on the differences in accuracy of the meters. Could these differences be due to experimental error?

Why does the variable area meter show less variation in head loss with flow rate than the other two meters?
Operating the Optional Software (F1-301)

Note: The diagrams in this section are included as typical examples and may not relate specifically to an individual product.

The Armfield Software is a powerful Educational and Data Logging tool with a wide range of features. Some of the major features are highlighted below, to assist users, but full details on the software and how to use it are provided in the presentations and Help text incorporated in the Software. Help on Using the Software or Using the Equipment is available by clicking the appropriate topic in the Help drop-down menu from the upper toolbar when operating the software as shown:

Load the software. If multiple experiments are available then a menu will be displayed listing the options. Wait for the presentation screen to open fully as shown:

Presentation Screen - Basics and Navigation

As stated above, the software starts with the Presentation Screen displayed. The user is met by a simple presentation which gives them an overview of the capabilities of the equipment and software and explains in simple terms how to navigate around the software and summarizes the major facilities complete with direct links to detailed context sensitive 'help' texts.
To view the presentations click **Next** or click the required topic in the left hand pane as appropriate. Click **More** while displaying any of the topics to display a Help index related to that topic.

To return to the Presentation screen at any time click the View Presentation icon from the main tool bar or click **Presentation** from the dropdown menu as shown:

![View Presentation Icon]

For more detailed information about the presentations refer to the **Help** available via the upper toolbar when operating the software.

**Toolbar**

A toolbar is displayed at the top of the screen at all times, so users can jump immediately to the facility they require, as shown:

![Toolbar Example]

The upper menu expands as a dropdown menu when the cursor is placed over a name.

The lower row of icons (standard for all Armfield Software) allows a particular function to be selected. To aid recognition, pop-up text names appear when the cursor is placed over the icon.

**Mimic Diagram**

The Mimic Diagram is the most commonly used screen and gives a pictorial representation of the equipment, with boxes to enter measurements from the equipment, display any calculated variables etc. directly in engineering units.

To view the Mimic Diagram click the View Diagram icon from the main tool bar or click **Diagram** from the **View** drop-down menu as shown:

![View Diagram Icon]
A Mimic diagram is displayed, similar to the diagram as shown:

The details in the diagram will vary depending on the equipment chosen if multiple experiments are available.

Manual data input boxes with a coloured background allow measured variables, constants such as Orifice Cd and Atmospheric Pressure, as appropriate, to be changed by over-typing the default value. After typing the value press the Return key or click on a different box to enter the value.

In addition to measured variables such as Volume, Time, Temperature or Pressure, calculated data such as Discharge / Volume flowrate, Headloss etc are continuously displayed in data boxes with a white background. These are automatically updated and cannot be changed by the user.

After entering a complete set of data from measurements on the equipment click on the icon to save the set of results before entering another set.
The mimic diagram associated with some products includes the facility to select different experiments or different accessories, usually on the left hand side of the screen, as shown:

Clicking on the appropriate accessory or exercise will change the associated mimic diagram, table, graphs etc to suit the exercise being performed.

**Data Logging Facilities in the Mimic Diagram**

Armfield software designed for manual entry of measured variables does not include automatic data logging facilities and these options are greyed out where not appropriate. When manually entering data the icon simply saves the set of entered data into a spreadsheet as described above.

**Tabular Display**

To view the Table screen click the View Table icon from the main tool bar or click Table from the View dropdown menu as shown:
The data is displayed in a tabular format, similar to the screen as shown:

As the data is sampled, it is stored in spreadsheet format, updated each time the data is sampled. The table also contains columns for the calculated values.

New sheets can be added to the spreadsheet for different data runs by clicking the icon from the main toolbar. Sheets can be renamed by double clicking on the sheet name at the bottom left corner of the screen (initially Run 1, Run 2 etc) then entering the required name.

For more detailed information about Data Logging and changing the settings within the software refer to the Help available via the upper toolbar when operating the software.

**Graphical Display**
When several samples have been recorded, they can be viewed in graphical format.

To view the data in Graphical format click the View graph icon from the main toolbar or click Graph from the View drop-down menu as shown:
The results are displayed in a graphical format as shown:

(The actual graph displayed will depend on the product selected and the exercise that is being conducted, the data that has been logged and the parameter(s) that has been selected).

Powerful and flexible graph plotting tools are available in the software, allowing the user full choice over what is displayed, including dual y axes, points or lines, displaying data from different runs, etc. Formatting and scaling is done automatically by default, but can be changed manually if required.

To change the data displayed on the Graph click **Graph Data** from the **Format** dropdown menu as shown:
The available parameters (Series of data) are displayed in the left hand pane as shown:

Two axes are available for plotting, allowing series with different scaling to be presented on the same x axis.

To select a series for plotting, click the appropriate series in the left pane so that it is highlighted then click the appropriate right-facing arrow to move the series into one of the windows in the right hand pane. Multiple series with the same scaling can be plotted simultaneously by moving them all into the same window in the right pane.

To remove a series from the graph, click the appropriate series in the right pane so that it is highlighted then click the appropriate left-facing arrow to move the series into the left pane.

The X-Axis Content is chosen by default to suit the exercise. The content can be changed if appropriate by opening the drop down menu at the top of the window.

The format of the graphs, scaling of the axes etc. can be changed if required by clicking Graph in the Format drop-down menu as shown:

For more detailed information about changing these settings refer to the Help available via the upper toolbar when operating the software.
# Contact Details for Further Information

**Main Office:** Armfield Limited  
Bridge House  
West Street  
Ringwood  
Hampshire  
England BH24 1DY

- **Tel:** +44 (0)1425 478781  
- **Fax:** +44 (0)1425 470916  
- **Email:** sales@armfield.co.uk  
  - support@armfield.co.uk  
- **Web:** http://www.armfield.co.uk

**US Office:** Armfield Inc.  
9 Trenton - Lakewood Road  
Clarksburg, NJ 08510

- **Tel/Fax:** (609) 208 2800  
- **Email:** info@armfieldinc.com